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Presidential Bits                                                
By Paul Howard, PATACS President 

In June, with the assistance of Arlington County 
Parks and Recreation staffers Carly Moser and 
Nakish Jordan, PATACS was given permission 
to move our AV storage cabinet to the first floor 
of Carlin Hall.  This is a dramatic improvement 
for meeting setup and tear down, eliminating the 
need to navigate the steep stairs to the second 
floor.  We're extremely grateful to these folks, 
and for the help and support we've had from Ar-
lington County staff and our friends with the 
Glencarlyn Citizens Association since we began 
meeting regularly at Carlin Hall in the summer of 
1986.  I recently came across newsletters from 
1993, when we were holding five meetings a 
month at the Hall. 

In the same batch of nostalgia, I found a printout 
of pictures of a meeting on February 27, 2002.  
Those pictures are posted on the historical ar-
chive of the NCTCUG.ORG website.  We were 
hauling 7 CRT monitors up and down the stairs 
for each meeting, connecting them to a VGA sig-
nal distribution box that could output to eight dis-
plays at a time.  The caption notes “Attempting 
to load Windows XP Professional on the demo 
computer:  A four-meeting exercise in futility! 
Don't try if your machine's > 2 yrs old !!”    

Don't remember how that was resolved, 'tho there 
are hints it may have required a new computer.  
From the pictorial record, it seems we kept lug-
ging those monitors up and down the stairs until 
acquiring a projector jointly with WACUG in the 
spring of 2004.                                                                              
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PATACS/OPCUG                                             
3rd Saturday, August 17 

Osher Lifelong Learning Institute,   
4210 Roberts Rd., Fairfax, VA 22032-1028    

                     
Meeting  1:30 PM  

 
Digital Literacy:                  
TV and Beyond -                          
Presented By                              
Douglas Povich                              

Digital Literacy is the set of skills needed to sur-
vive in the Information Age. Becoming digitally 
literate requires an understanding of the vast and 
ever-changing array of information sources, how 
to manage or cope with technology delivering 
the information and how to make sense of the 
huge amount of information that we are subject-
ed to each day. Television, radio, newspapers, 
magazines, social media and, of course, the inter-
net are increasingly important sources of infor-
mation necessary to our daily lives. The Fairfax 
County Department of Cable and Consumer Ser-
vices will discuss how to evaluate the infor-
mation sources and delivery technologies availa-
ble today with a goal toward helping you to ef-
fectively use technology to find, identify, criti-
cally analyze, and use information in the digital 
age. 

Douglas Povich is a Management Analyst in the 
Communications Policy and Regulation 
D.ivision of Fairfax County’s Department of Ca-
ble and Consumer Services where he works on 
cable TV, media and technology issues. Before 
joining the County in 2017, Doug practiced tele-
communications and technology law for over 
thirty years. 
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This could be a personal security concern in 

any public place, especially any crowded place.  

The Washington Post article led to me investi-

gate how to silence my smart phone virtual 

keyboards. 

An Android phone Exmple                                    

On my Samsung Galaxy S7, running Android 

OS version 8, I opened Settings, as shown in 

Illustraiton 1, and tappped Sounds and Vibra-

tion. . 

 

Learn In 30 

More Power To You –                            
Presented By John Krout 

This is a sequel to John's February 2019 presenta-
tion on Power Banks, which are portable hand held 
batteries with USB sockets for charging devices 
such as smart phones and tablets.   

This presentation will focus on charging laptop 
computers and USB devices while in cars, airports 
and even airplanes.   

You learn about and see a variety of inexpen-
sive solutions for both AC power and USB 
power in cars, abundant AC and USB power 
from a single AC socket in airports, and even 
the beginnings of a portable AC solution for 
laptop recharging on airplanes. 

SILENCE YOUR VIRTUAL KEY-

BOARD:  How and Why                                  
By John Krout, PATACS member 

A Washington Post article published on June 7, 

2019 reported that malware for smart phones 

and tablets may listen in when you type on a 

virtual keyboard, using the sounds produced by 

key taps to determine, for instance, your pass-

words.  

No such malware has been reported, but a uni-

versity security research group explored the 

possibility and found such malware was feasi-

ble. 

Although the article did not mention it, this sug-

gests an analogy to "shoulder surfing", the term 

referring to someone who watches over your 

shoulder as you type.  

A person sitting nearby could simply use an au-

dio recording app to rec -ord sounds when you 

type, and then convert the sounds when you 

type, and then convert the sounds to keystrokes 

later. Call it Audio Surfing. 

Continued Page 3 

Illustration 1 
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Another screen appeared, as shown in Illus-

tration 2 below. 

There I clicked on Volume , and another 

screen appeared, as shown in llustration 3 

at right.  

There are four different volume controls on 

that screen: Ringtone, Media, Notifications, 

and System. 

Ringtone obviously covers ringtones, and Me-

dia covers videos and audio.  Notifications 

covers apps notifiying you of events, such as 

arrival of a new text message.  

Each line shows the curernt volume setting by 

the position of the large dot. All the way left is 

Muted, and all the way right is Maximum Vol

- 

 

 

 

 

-ume. You can Tap and Drag each button to the 

right or left. 

I did not have a good idea of what System cov-

ered, but I tried muting System by sliding the 

large dot on that line all  the way to the left. Sure 

enough, when I muted the volume for System, 

and tested my keyboard by typing a memo, the 

keyboard sound was completely silent. 

System volume covers other things too. For in-

stance, normally a sound is made when creating a 

screenshot, like I did for each of the illustrations, 

but muitng System sounds eliminated the screen-

shot sound too. 

Il

Illustration 3 

Illustration 2 



Page 4 PATACS Posts AUGUST 2019                      

www.patacs.org  

Continued Page 5 

 
   

 

 

 

 

Illustration 4 

An iPhone Example                                                                   

On my iPhone 6s, running iOS 12.2, I opened Settings, 

as shown in Illustration 4 on left, and in that screen I 

scrolled down to Sounds, a shown in Illustration 5 on 

left, I tapped Sounds, and a new screen appeared, as 

shown in Illustration 6 below. 

Illustration 5 

Illustration 6 
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 An iPhone Example                                                      

Scrolling down to the bottom of the Sounds  

screen, as shown in  Illustration 7 below, I found 

that a switch for Keyboard Clicks was On by de-

fault. I turned it off by tapping the switch.  

After that, I tested the effect of turning off that 

switch by typing a memo. Sure enough, I found 

that the keyboard definitely no longer made a 

sound. 

 

Is this a realistic security concern?                         

And now, a critique of the Washington Post re-

port. As best I can tell, the default virtual key-

boards on both of my smart phones do not make 

an individual sound for each key. For instance, 

the E key does not sound different from the K 

key to me.  I could be wrong; like many over 

the age of 60, my hearing is not what it once 

was, so maybe the sound is in fact unique for 

each key on a virtual keyboard. Alternative vir-

tual keyboards are available in the app stores for 

Apple and Android. There may be alternate vir-

tual keyboards that do indeed produce a unique 

sound for each individual keystroke, so that the 

E key sounds different than the K key. If those 

alternatives exist, I suggest that you disable the 

keyboard sound as described above. If the alter-

native keyboard allows you to silence it by its 

own configuration, then you can do that to still 

make other Android System sounds audible. 

A far riskier behavior                                                   

Another thought: using assistants such as Siri or 

Alexa or Cortana to dictate verbally an ID or/or 

password verbally offers a much more signifi-

cant risk: malware and audio surfers can over-

hear you and understand your ID and password 

exactly. 

ABOUT THE AUTHOR: John Krout has been 

using personal computers since the late 1970s, 

and remains fascinated by all the uses, good and 

bad, of personal computers and their younger 

siblings, portable computing devices. He was a 

president of the Washington Area Computer 

User Group (WAC), a predecessor of the Poto-

mac Area Technology and Computer Society 

(PATACS). He is a frequent contributor to 

PATACS Posts and has occasionlly presented 

demos at PATACS meetings. He works now as 

a technical writer for the Thales Group, a major 

maker of automated fingerprint identification 

systems, supporting the use of that hardware by a 

major federal agency. He hopes to retire soon; that 

won't change his interests, though it might 

change his budget for new tech. Illustration 7 
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Style Sets: You can apply a group of style fea-
tures to a whole document at once using Style 
Sets. This includes features on the Home tab in 
the Font and Paragraph groups. In Word version 
2013 and later, Style sets are found on the De-
sign tab. Open this tab and click the More icon 
at the right end of the Document Formatting 
group to see the built-in style sets. Preview how 
these would look on your document by clicking 
anywhere in the document and moving your 
mouse pointer slowly over the gallery. Click a 
set to apply it to your document. If you change 
your mind, remove the style by clicking the Un-
do icon (a left-curving arrow at the top left 
above the ribbon) or pressing Crtl+Z on the key-
board.  

Modify or Create 
a New Style: 
Sometimes, you 
won’t find the style 
part you want in 

the gallery. This is when you can change a gal-
lery style or make your own. To create a new 
style and add it to the gallery for future use, 
open a document and select a heading. Using 
the tools in the Home tab > Font group, make 
your changes. With the newly styled text select-
ed, click the More icon and then click ‘Create a 
Style’ to open the ‘Create New Style from For-
matting’ box. Give the new style a name that 
relates to its features and click OK. Your new 
style will appear in the Styles gallery. I named 
my heading, “Blue Antique Heading,” based on 
the font I used. If you don’t find your new head-
ing style in the gallery, click the More icon 
again, click Apply Styles and then click the new 
heading style name. Now you should see it in 
the gallery.  

Two Ways to Add Style to a Word Document 
By Nancy DeMarte, 1st Vice President, Sarasota 

Technology Users Group, FL     
www.thestug.org    ndemarte (at) verizon.net 

Microsoft Word is loaded with features that give 
style to documents. “Style” in this case means 
modifying the look of text and paragraphs. To do 
this, many users change the font or font size, add 
effects like bold or color and maybe change the 
space between lines. These changes are made one 
at a time and can be time-consuming. Plus, you’ll 
have to do it again the next time you want that 
style. There are tools, however, that add style in 
easier and more coordinated ways. The first one is 
on the Home tab > Styles group. This gallery con-
tains what could be called “Style Parts” because 
they add style to parts of documents like titles and 
headings. The other style-adding feature is the 
Document Formatting group on the Design tab. 
This gallery lets you apply a group of stylistic fea-
tures to a document all at once. These are called 
“Style Sets.” Here are a few tips for using Style 
parts and Style sets.  

Style Parts: The Styles group 
on the Home tab offers several 
styles which can be applied to 
parts of documents or used to 
create a special kind 
of  document, like a company or 
club logo. To see the entire 

Styles gallery, click the More icon at the right end 
of the Styles group. Let’s say you have a document 
with headings above each paragraph, as this article 
has. You would like to give them a different ap-
pearance from the rest of the text. To preview how 
some options would look, select your first heading 
and move your mouse pointer over the styles in the 
gallery to see how they change the heading. When 
you find one you like, click it to apply the style to 
the first heading. But what about all the other head-
ings in your document? This is where Format 
Painter can help. Select the heading to which you 
just applied a style. Then double click Format 
Painter on the Home tab > Clipboard group to keep 
Format Painter enabled. Drag your mouse across 
each of the remaining headings to apply the same 
style as the first one. When done, click Format 
Painter once to turn it off and save the document. I 
created and applied a style to the headings in this 
article as an example. It has a different font, font 
size, and color from the rest of the text.  
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. Is the CPU the PC Shopping Key?
News and/or opinion from Paul Baecker, 

Editor, Sterling Heights Computer Club MI 
WYSIWYG     www.shcc.org                                 

newsletter (at) sterlingheightscomputer-
club.org 

With the pending demise of all Microsoft sup-
port on January14, 2020 for what is possibly 
their best operating system to date (Windows 
7), many users will be shopping for a new PC 
as one of their solutions. Another solution 
could be to install Linux onto that Windows 7 
PC as a ‘dual-boot’ configuration, so that the 
user can safely surf the web using the Linux 
boot option, but still maintain the Windows 
partition with needed Windows applications 
(just don’t go web surfing with it). 

If a new PC is the choice, how to go about it? 
Well, I look at buying a new computer sort of 
like buying a new car (or SUV if we believe 
the trends). What is the first thing about a new 
vehicle that we think of? I’d say it’s the en-
gine. You can select a 4-cyl or 6-cyl or hybrid 
or electric motor. But once you buy it, can you 
return to the dealer and switch it if you have 
second thoughts? Nope. I look at this akin to 
choosing a PC with a particular  

CPU. Generally, you can’t switch the CPU 
(OK, you extreme tekkies, this column isn’t 
for you!) once you make your purchase. You 
can usually increase the RAM or switch from 
an HDD to an SSD, and such things that en-
hance the PC’s performance, but you’re stuck 
with the CPU performance that came with that 
sparkling new PC. 

When you see 5 PCs on the store shelf, all 
with the same price, how to choose? How to 
select the ‘right’ PC, despite what the over-
anxious salesperson might push you into buy-
ing? A little homework, that’s how.  

The www.passmark.com web site is your new 
pal. It compares relative performance among 
over 2700 CPUs from Intel and AMD. AMD 
is Intel’s primary PC CPU competitor, and a 
CPU brand certainly worth considering (the 
two manufacturers keep leapfrogging over 
each other with new CPU technologies —  

Continued Page 8 

 

For those with Word 2007 or 2010, the steps dif-
fer a bit. Click the Home tab, and in the Styles 
group, click Change Styles, then point to Style 
Set. Preview it the same way as described above. 
Then click a style set to apply it to your selected 
document.   

Style Set as Default: The default style set in Word 
is called Normal. This means whenever you type 
in a blank document, all the features of the Nor-
mal style set will be used.  

If you wish to modify the Normal style, make 
your changes, but give it a new name, which will 
leave the Normal style set intact.  

We do this so it doesn’t cause a problem when 
you open older documents. Microsoft has 
changed its Normal style properties over the 
years. (For example, Arial was at one time the 
default font; now it’s Calibri.)  

You can choose any Style set to become the de-
fault. First, apply all the features you want. Then 
preview how it would look and add it to the Doc-
ument Formatting gallery.  

Finally, click its gallery thumbnail, and click “Set 
as Default” which appears at the right end of the 
Document Formatting group.  

Now all new documents will be formatted accord-
ing to your default Style set. You can change the 
default style at any time.  

The way to master Styles is to start small, such as 
applying headings or titles using the Styles gal-
lery on the Home tab.  

After Microsoft changed the default line spacing 
from 1.0 (single space) to 1.15, I created a style 
that was single-spaced. That was the only change 
I made to the Normal style, but it comes in handy 
when I want to save space. 
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Intel just advertises more, and you pay for that treat). The site also has other hardware benchmarking 
features (RAM, video cards, drives, much more), but we’ll stick to CPUs in this article. 

• To check the overall performance of a CPU on passmark.com (which is a FREE site), you do this:  

• Go to www.passmark.com 

• Select Benchmarks from the menu and then down to CPU Benchmarks. 

• Click on the "Search for your CPU model" selection. 

• The heading will be "CPU List". Below that, "Single CPU Systems." 

• To the right of that, there is an empty box, with a "Find CPU" button next to it. This is where 
you'll enter the CPU model for which you want a ranking. 

For example, a PC you're interested in contains an "Intel Core i7-8565U Processor at 1.8GHz" proces-
sor. Copy/paste the processor model (in this case, "i7-8565U") into that box (without the quotes). A 
greyed box will open, listing all of the processors that pertain to that model (for example, there could 
be something like an i7-8565UX model, too). It will list all of the CPUs in the same model family. 
For this 8565 CPU, there is only one model. The site is a bit finicky. You need to enter the proper 
CPU ID including a dash — for example, like i7 (for Intel) or A10 (for AMD), and then the model 
number, usually with a dash between them — in order for the site to display it. Keep trying — you’ll 
get the hang of it quickly. 

Click on the selection to get it entered in full in the box that was previously empty. It’ll look like this: 

Then you can click on the Find CPU button, and you'll see the resulting ranking: 
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       So, the CPU in this PC is ranked 387 for overall 
performance among about 2700 listed CPUs. Re-
member that "1" is the CPU with the highest over-
all performance (you can click on “Rank” at the 
top of the listings to see everything in perfor-
mance order — you can sort on any of the col-
umns there). A ranking above 400 is pretty darned 
cool these days and will all-but-promise you a 
high-performing PC for many years to come. 

This web site has many other features, but in my 
opinion, this CPU-performance ranking is the 
most useful to typical PC shoppers. The site can 
also compare up to three CPUs at a time. Clicking 
on any of the CPUs in the list will display win-
dows with additional qualities — power consump-
tion, number of cores, clock speeds, pricing 
(which changes day-to-day), and more. 

Blocks and Bits 
An Introduction to Blockchain 

By Joan Grace, Publicity,                                           
Northeast Ohio PC Club 

Nybbles & Bytes 
www.neopc.org 

Blockchain is a distributed, decentralized, public 
ledger. (Investopedia) In simple terms, if you con-
sider a standard database, it’s like a pile of credit 
cards on the floor of a bank vault; with block-
chain, it’s as if each credit card were in a safe de-
posit box inside the bank vault.  
 
Blockchain is a growing list of records, called 
blocks, which are linked using cryptography. 
Each block contains a cryptographic hash of the 
previous block, a timestamp, and transaction data. 
By design, a blockchain is resistant to modifica-
tion of the data. (Wikipedia) 
 
Blockchain technology promises to transform 
finance the way the internet transformed commu-
nication.  
Blockchain is the technology that runs Bitcoin. 
There have been technologies similar to Block-
chain, but none of them combined all the three 
features of Blockchain: Peer-to-peer Network, 
Cryptography, and Proof of Work.  
 
In addition, blockchain technology can be used in 
other applications as well; e.g., tracking votes, 
registering auto titles, managing medical records. 

So, when you visit a store (or a retail web site) 
and observe so many PCs available to your 
wallet, consider making notes of the various 
CPUs in PCs in your price range. Peruse their 
overall performance on this site. 

Also consider upping your price range just a 
bit to get a much-higher-rated CPU, knowing 
that later you can alter those other PC compo-
nents to enhance that PC (RAM, drive, etc.).  

Then go shopping. Some stores offer a return 
period with a full refund (avoid stores with so 
called ‘restocking fees’!!!), so that you can test 
drive your new digital toy at home, particularly 
useful since you really cannot put any PC to 
the test in a store.  

Just ask about it. 

Bitcoin is a cryptocurrency, a 
form of electronic cash. It is a de-
centralized digital currency with-
out a central bank or single ad-

ministrator that can be sent from user to user 
on the peer- to-peer bitcoin network without 
the need for intermediaries. (Wikipedia)
Bitcoin is world’s first revolutionary crypto-
currency and a digital payment system. There 
are other cryptocurrencies as well. 

Cryptocurrency is a digital or virtual curren-
cy that uses cryptography for security between 
individuals, and for anti-counterfeiting 
measures. This means users must reach a con-
sensus about cryptocurrency's value and use it 
as an exchange medium. A defining feature of 
a cryptocurrency, and arguably its biggest al-
lure, is its organic nature; it is not issued by 
any central authority, rendering it theoretically 
immune to government interference or manip-
ulation. 
 
Blockland:  Cleveland is building a block-
chain technology ecosystem; Blockland is a 
group of civic and business leaders working 
on making Cleveland a tech hub.  The Block-
land initiative exists to educate and promote 
real-world blockchain applications, while es-
tablishing and leading a blockchain ecosystem 
with support from private, public and philan-
thropic individuals and organizations to: 
 Continued Page 10 

**************************************         ************************************** 
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Educate - Provide for an emerging workforce 
and leaders in blockchain technology. 

Lead - Demonstrate innovation and real-
world application of technology in the 
Midwest. 

Establish - Create a local ecosystem where 
partnerships leverage blockchain technol-
ogy. 

Do not confuse a web browser with a search en-
gine. A search engine, such as Google, is a web 
page that you use to search the internet for some-
thing – and you can get to Google on any brows-
er. All web browsers will do the same things, 
maybe in slightly different ways, and it is up to 
you to pick the ones you like to use. Here are 
some tips and information for using any browser:  

1. You need internet access to use a browser. If 
you do not have internet access and try to use 
it you will get a message that you are not con-
nected. 

2. Use the “search/address bar” to enter either text 
you want to search the internet for OR a web page 
address (like www.thestug.org). The browser will 
determine if you are doing a search (not entering a 
valid web address) and will use the default search 
engine to do the search and display your results. 
Firefox, for example, will use Google by default 
as its search engine. Most browsers will allow you 
to change the default to another search engine in 
“settings.” If you enter a valid web page address 
you will “go to” and see that web page.  

3. The “search/address bar” displays the web page 
address of the page you are looking at. You can 
highlight and copy this address to paste it in a 
document, email, etc.  

Promote - Blockchain has incredible potential 
to be inclusive in serving the greater good. 

 
Part of the effort involves a proposed real estate 
deal that would create a space dedicated to hous-
ing start-ups and coders, nick-named the City 
Block. 

4. As you browse the internet and click on differ-
ent things, new web pages will be displayed – and 
you are creating a “chain” of web pages. Not eve-
ry “click” will create a new web page in the chain, 
some may create a new “tab,” for example. Use 
the “left and right arrows” to go to previous web 
pages (left) or to web pages you have already 
viewed (right).  

5. The little “house” or “home” icon will take you 
back to your starting web page.  

6. The menu of options, including “settings,” 
“help,” and more is displayed by clicking on the 
three lines (called a “hamburger”) or three dots in 
a vertical line.  

7. TABS – those things on the top row of your 
browser (or near the top), are used to create a new 
“window.” You may think of a tab as if you 
opened another session of your browser. As you 
click on different links sometimes a new tab will 
be created for you. Tabs can be helpful if you 
learn how to use them. Create a new tab by click-
ing on the plus sign “+” at the right end of the tab 
row. It is easy to return to a web page by clicking 
on the tab. In your browser settings it is possible to 
have a set of tabs opened and ready for you when 
you open the browser.  

8. SETTINGS – Can provide the many options, 
help, and defaults for your browser. Most brows-
ers will have a video of how to use it and will de-
scribe what each setting option does.  

9. By all means go to Google and ask, “How do I 
use Google Chrome” (or any browser you prefer) 
to see videos and help. Take a few minutes to 
learn more about your browser!  

10. FAVORITES or BOOKMARKS will let you 
create a list of all your favorite web pages. You 
can organize this list any way you like, including 
creating “folders.” Clicking on a bookmark may or   
may not create a new “tab.”  

**************************************         *************************************** 
Using a Web Browser                                    

By Jim Cerney, Forum Leader, The Sarasota 
Technology Users Group, FL                                       

The STUG Monitor                                      
www.thestug.org                                              

jimcerny123 (at) gmail.com 

Have you heard of Google Chrome, Microsoft 
Edge, Firefox, or Safari? Well, they are all Inter-
net Browsers – apps (programs or software) that 
allow you to see web pages and cruise the inter-
net. No computer should be without one! Win-
dows computers come with Microsoft Edge in-
cluded for free, but the others are free as well.  
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11. History, cookies, and other records are creat-
ed by all browsers. Look in settings and ask 
Google about the options for your browser to 
turn off these things or to delete them. Usually it 
is a good thing to delete your history upon exit-

We’ve all heard about all the hackers and the da-
ta breaches that have happened to so many on-
line sites. We shudder when we hear the names 
of the sites. But, what we don’t know is if our 
own email address and passwords were actually 
compromised. 

There is a website, haveIbeenpwned.com, that 
has collected the information published by  
hacked companies when they disclose those 
email addresses that have been compromised.  

This website has been operational for five years, 
gets about 60,000 visitors a day and seems to be 
a safe site to use. Its purpose is to provide the 
general public a convenient way to see if their 
private information has been leaked or compro-
mised. 

When you bring up the haveibeenpwned.com 
site, you are greeted with a field to type in your 
email address and instructions to “Check if you 
have an account that has been compromised in a 
data breach.”  

It is safe to type in your email address. You 
aren’t disclosing any information that isn’t all 
over the web already. 

After you type in your email address and click on 
“pwned?”, you will either get Oh ho – pwned! Or 
Good news – no pwnage found! If you have been 
part of a breach, you will see a description of 
each breach along with the date of the breach and 
what was compromised.  

In my case, my email address and password were 
compromised in the Adobe breach of 2013 and in 
the Zomato breach in May of 2017. It suddenly 
seemed like a really good idea to change my 
password. 

 

 ing your browser session. Learning is good for 
you. And learning how to use your browser 
opens up more ways to learn using the internet. 
Enjoy your potential. 

 You can select an option for the site to notify 
you if your email address shows up on any new 
list of breaches email addresses. When you select 
“notify Me” from the page menu, you’ll get to 
prove you are not a robot and you’ll be sent a 
verification to confirm that you are real. 

If you discover that you have been breached, do 
change your password on that email account. Al-
so9, if you use that same password on other ac-
counts, change them also. 

“Let’s be careful out there!” 

How to know if you’ve been hacked 
Worried you've been hacked? Use these 

sites to find out and protect yourself 
By Tyler Lacoma, Digital Trends  

The best way is to find out if your security has 
been compromised as soon as possible so you 
can take personal action, which is where data 
breach detection websites come into play.  

These sites allow you to securely search through 
the latest hacked data to see if any of your sensi-
tive information is at risk. We’ve rounded up 
four of the best for you to use based on your se-
curity needs, so let’s dive in. 

******************* ********************       **************** ********************         

Let’s Be Safe Out There                                         
By Matt Batt, President,                                               
The Computer Club, FL                                            

https://www.scccomputerclub.org                        
mbatt453 (at) gmail.com 
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works hard to track down breaches, verify them as 
legitimate, and nab data so you can check it out. 
You can read more about site runner Troy Hunt 
and his thoughts on the business here. 

Once you log onto the site, you’ll be greeted with a 
basic search bar and a list of the latest and largest 
breaches. Just type in your email or username, and 
the site will search the breached data and show-
case any red flags. You can also search more sen-
sitive breaches, but only if you take the time to 
verify your email address. There’s also an option 
to deep link straight to a particular account, so you 
can instantly bring up results for one particular 
email address if you plan on doing a lot of repeat-
ed searches. 

It’s a simple tool that still allows for some custom-
ization as needed. Moreover, it’s obvious that Hunt 
really cares about this sort of white hat work, as 
well as educating users on 
the dangers of data breaces 

Password Managers                                             
Windows 10 Forum,                                                          

By Dave Gerber,                                                               
Sarasota Technology Users Club, Florida 

www.thestug.org                                                       
davegerber1 (at) verizon.net 

A question about Password Managers came up 
during the Windows 10 Forum at the July STUG 
Meeting so I thought I'd share some info common 
to all of the best known and reputable programs ... 
Dave Gerber 

Password managers are the most recommended 
tool by security experts to protect your online cre-
dentials from hackers. But many people are still 
hesitant to use them. Here’s why password manag-
ers are safe, secure, and your best defense against 
password-hungry cyber criminals. 

What is a password manager?                                         
Think of it like a safe for your passwords. When 
you need something inside the safe, you unlock it. 
Password managers work the same for your online 
credentials. 

You create a single, super-strong password, which 
acts like a key. Install the password manager app 
on your phone, computer, browser, and other de-
vices. Your passwords are securely stored inside it. 
Anytime you need to log in to an account, unlock 

 

 

your password manager and retrieve your login 
info. 

With website vulnerabilities and security inci-
dents on the rise, many people have grown to 
mistrust a tech tool to manage their passwords. 
What if the password manager gets hacked? 

Reputable password managers take extra steps 
to lock down your info and keep it safe from 
cyber criminals. 

A good password manager: 

Doesn’t know your master password (so 
hackers can never steal it) 

Encrypts all your data 

Does not store any of your data on their 
servers 

Can generate strong, secure password 

No privacy tool can completely guarantee your 
online safety. Even the most elaborate lock can 
be broken into. Yet we still lock our doors to 
our houses and cars. 

The alternative to using a password manager is 
to rely on your own memory to remember all 
your credentials. This inevitably leads to recy-
cling passwords or using variations — a bad 
habit that hackers love. 

Password managers can be such an effective 
security tool because they help us improve bad 
habits. With a password manager installed on 
your computer and phone, it’s a lot easier to 
take your logins everywhere so you can use 
unique, strong passwords on every account. 

Password managers don’t store all your cre-
dentials together in one place. Any data you 
store in a password manager — passwords, 
logins, security questions, and other sensitive 
info — is securely encrypted. Even if the pass-
word manager gets hacked, cyber criminals 
would not be able to see your logins. 

The only way to access your data is with a sin-
gle master password that only you know. You 
use this password to unlock the manager on 
your computer, phone, or other devices. Once 
it’s unlocked, a password manager can fill in 
your logins to websites and apps. 

 

 

 

teasilyfwhatever 

gets hacked? 

https://www.troyhunt.com/the-impact-of-have-i-been-pwned-on-data/
https://www.troyhunt.com/the-impact-of-have-i-been-pwned-on-data/
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Our memories sometimes fail us. Ever clicked a 
“forgot password?” link? It’s very common to use 
variations of the same password to make them easi-
er to remember. With a password manager, you 
don’t need to remember any of your credentials. It 
can be installed on all your devices and will auto-
fill your passwords for you. Once you get in the 
habit of using one, you’ll no longer have to worry 
about forgetting your credentials.                                

As the old saying goes, “When the going gets 
tough, the tough go shopping.” Here in the 21st 
Century, we don’t have to be as tough to be shop-
ping because now a lot of shopping can be done 
online. In terms of placing orders, methods of pay-
ment, shipping, etc., I really don’t have anything to 
contribute. But the browsing and research neces-
sary to make a selection has been radically trans-
formed and enhanced in a lot of unexpected ways. 
Here are a few. One of the nice things about going 
to an old-time store was to be able to pick up and 
inspect an item. That was a plus for in-person shop-
ping, though maybe not enough if the item was 
sealed and/or shrink wrapped. Something I discov-
ered that I found to be much, much more useful 
and better was to do a search on a potential selec-
tion in the YouTube search box, and add this word, 
“unboxing.” Then, click on one of the search re-
sults and watch a video on the selection. Often-
times, the video will be done by a store salesman 
with not only product knowledge but practiced 
communication skills that he will use to describe 
things understandably. He’ll hold up the contents 
one by one and identify them for you. It just might 
help.  

Another useful online research technique is to look 
at the reviews for an item on Amazon. From what 
I’ve seen, Amazon allows just about anyone, not 
just the pros, but actual users and customers, to 
compose and upload a review of just about any 
item posted. The reviewer has to give a rating from 
one to five stars and then has space for further ex-
planations. Many leave only very terse comments,  
if any, but there are a surprising number who offer 
long stories and multiple reasons for their ratings. 
These authors seem to have acquired a purpose in   

 Sure, it takes time to log all your credentials in a 
password manager. But you don’t need to do it all 
at once. You can always start small and change 
just a few passwords at a time. Try installing a 
password manager and creating new, unique pass-
words for the websites you visit most frequently. 
Over time, as you log in to other sites, you can 
add others. 

 
*********************** *********************** *********************** 

Research Before Online Shopping                       
By Richard Durand, President,                                           

Wisconsin All-computer Users Club, WI-
WAUCtalk      https://www.wauc.us                                                                                                             

rgdurand (at) yahoo.com 

life of informing the rest of the world about their 
experiences with a product or a company’s cus-
tomer service. Personally, I’ve got better things 
to do, but I’ll gladly take advantage of the re-
views of others.  

And the one final method of research, which is 
blatantly obvious, but still worth mentioning, is 
to just enter a product name or even just a gen-
eral category, such as “scanner” or “RAM,” into 
the box of a browser search engine, such as good 
old Google, and add this word, “reviews.” There 
might be lots and lots of search results, some of 
which might prove to be very useful. One I like 
to see is something along the lines of “What to 
look for in a ? (whatever).” Or there might be a 
result along the lines of “Top ten headsets, or 
widgets, or whatever.” Even if there is no worth-
while product to select, such searches might re-
veal some very important information, such as 
what critical attributes to look for, what price 
range to expect, and what local establishments 
have this type of product available. 

For me, positive or negative reports are less im-
portant than the information provided. Some-
thing that’s praised to the skies might not be 
what I’m looking for, and something else that’s 
condemned in a review might be just what I 
need. Numerical ratings are just opinions, at 
best, starting points, and are secondary. The in-
ternet empowers one to make up one’s own 
mind about shopping and about a lot of other 
things, so one might as well use one’s own mind. 
And if enough of us do our online shopping with 
these methods, I am convinced that the vendors 
will be motivated to improve in price, quality, 
and customer service. For them, it’s getting more 
and more competitive. And for us, all of this can 
be done from one’s own computer, tablet or 
smartphone.  

Happy shopping!  
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As I continue to delve into the ramifications of 
targeted marketing and how it might affect us in 
our everyday lives, I’m diverted to the Internet of 
Things (IoT). A little research on IoT and how 
data from seemingly innocuous devices could be 
collected and used, proved enlightening, with a 
tremendous amount being written on this subject. 

How will this data flow through the various col-
lection systems? Will data be captured in real 
time or transmitted in anonymous batches? How 
will it be used, and who will have access to the 
purportedly anonymous data sources? Devices 
supplying data could include fitness wearables, 
various accessories in cars, IoT equipped appli-
ances, such as refrigerators, washers, dryers, 
health trackers, Smart TV’s, security cameras 
and devices, web connected eyeglasses, and the 
list goes on.     

IoT devices will outnumber the world’s                                              
population this year for the first time. 

A recent study indicated that over half of those 
surveyed would be willing to receive some ads. 

This, of course, indicates that some form of data 
tracking is needed, not only of our computers 
and phones, but of the fitness monitors used to 
track our physical activity, the refrigerators mon-
itoring our supply of milk, or the processor in 
our new car monitoring our driving! 

Much of the data can be used for non-nefarious 
purposes, such as product improvement and fu-
ture product development. But will some of this 
data be used to extrapolate future drug health 
care needs, based on current fitness monitor 
feedback data? Will this data find its way into 

 

insurance actuarial tables? And, of course this 
data will be used for more fine grain targeted 
marketing? The management of this data has, in 
fact, spawned new companies who will monetize 
this valuable data. It will be another learning ex-
perience, as hopefully the public is able to decide 
what is acceptable and what is not. 

On the plus side, IoT can help create Smart 
Homes and improve machine efficiency, such as 
heating and cooling devices. IoT can be used in 
wearables for security and identification, health 
monitoring and reporting, smart retail and inven-
tory control, optimization of farming, and supply 
chain activities, to name a few.  

Many positive things come out of the use of IoT 
data, such as Rolls Royce using this data, along 
with artificial intelligence (AI), to create busi-
ness benefits to customers and improve their 
products. They have created “Data Innovation 
Cells” which use collected data to test new ideas 
to improve performance, maintenance cycles, 
and safety, and develop product improvements. 
It is certain that data from IoT connected devices 
will unlock efficiencies, spawn innovation, and 
lead to meaningful insights of all kinds! 

So, the IoT is actually being used in numerous 
positive ways, and engineers are just beginning 
to see all the potential benefits. Of course, put-
ting sensors and retrieving feedback from every 
process can result in an overabundance of data, 
which may or may not prove useful. While all of 
this can be viewed as an overwhelming invasion 
of privacy, it can also be looked at as an exciting 
step forward and a world full of new opportuni-
ties, with positive outcomes around every corner! 

 

Your opinions about the philosophy of the article below??? (ed.) 

Internet of Things Data Tracking                                                                                             
By Jeff Wilkinson, Present, Sun City Summerlin Computer Club, NV                                                           
igabyte Gazette         www.scs-cc.com         pres.scscc (at) gmail.com 
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       Meeting Information and Agenda         OPCUG / PATACS Saturday Meetings                                                                                                                                            

12:30 – Social time in Coffee Room and Annex 

1:00 – 1:05: TA-1: Meeting Start –                                 

Introductions, Announcements    

Please silence phones.      

1:05 – 1:19: Q&A – detailed responses may be 

deferred to post-meeting communication. 

1:20 – 1:50: 'Learn in 30' Presentation               

1:50 – 2:00: Break in Coffee Room / Annex 

2:00 – 3:20: Featured Presentation                                  

3:20 – Door Prize Drawings (usually 3) for each 

group. Eligibility - group members only. 

3:30 – Adjourn (Expect some flexibility in sched-

uled times. Order may be varied to accommodate 

scheduling needs of our valued presenters.) 

 

In June and December, a PC Clinic / Tech Help 

session is run concurrently with the meeting from                  

1 PM in the Annex.                                                           

See: https://www.patacs.org/clinicpat.html 

With the concurrence of presenters, meeting ses-

sions are webcast using the Zoom.us cloud meet-

ing service.  

Dues-paid members may 'attend' from remote lo-

cations, using the meeting number information 

provided on the PATACS website.  

                                                                            

Please see:                                                                  

https://www.patacs.org/mtgdetpat.html#3rdsat                                                      

Need more information about Zoom?                          

Contact: webinarhosts@patacs.org                                                                      
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 AUGUST PATACS Event Calendar 
           Call (703) 370-7649 for Meeting Announcements 

Visit Our Web  Site: http://www.patacs.org       Free Admission       Bring a Friend!                                                                                                     

SUN          MONX      TUE       WED      THUR     FRI   SAT       

       

Arlington: Carlin Hall Community Center                                 Fairfax: Osher Lifelong Learning Institute                                                                                                                                           

X               5711 4th Street South                                                                    4210 Roberts Road                               x               

xxxxxx  Arlington, Virginia 22204                                                               Fairfax. Virginia 22032                                                                     
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